eCLINICALWorks P2P Guide

Version 2.0

A guide to building networks and collaborating with providers using eClinicalWorks P2P.
# CONTENTS

## ABOUT THIS GUIDE
- Product Documentation
  - Finding the Documents
  - Webinars
  - eClinicalWorks Newsletter
- Getting Support
- Conventions

## ABOUT eCLINICALWORKS P2P

## ACTIVATING eCLINICALWORKS P2P
- Administrative Security Settings
  - Enabling the P2P Security Attribute
- Practice Activation
  - Administrator Level
  - Provider Level

## REGISTRATION

## POST-REGISTRATION
- Settings
  - Your Profile Picture
  - Schedule Access

## BUILDING YOUR eCLINICALWORKS P2P NETWORK
- Sending Invitations
- Accepting Invitations
  - eClinicalWorks Users
  - Non-eClinicalWorks Users
- Managing Invitations
- My Favorites

## REFERRALS
- Sending Referrals

## SCHEDULING
- Creating eCW P2P Appointments
- Managing eCW P2P Appointments
ABOUT THIS GUIDE

This guide details the activation, configuration, and usage of eClinicalWorks® P2P, for eClinicalWorks users and non-eClinicalWorks users alike. eClinicalWorks P2P is enabled for eClinicalWorks users on Version 9.0 and higher.

For questions about using eClinicalWorks P2P in your practice, contact eClinicalWorks Sales at: sales@eclinicalworks.com

Product Documentation

The following documentation supports eClinicalWorks Electronic Medical Record (EMR), Practice Management (PM), and/or additional software features:

- System Administration Users Guide
- Front Office Users Guide
- Electronic Medical Records Users Guide
- Billing Users Guide
- Release Notes
- Patient Portal Users Guide
- eClinicalMessenger Users Guide
- eClinicalMobile Users Guide
- eBO Canned Reports Users Guide
- eBO Metadata and Query Studio Users Guide

Finding the Documents

eClinicalWorks Documentation is available from the following:

- The my.eclinicalWorks Customer Portal: https://my.eclinicalworks.com

Webinars

For more information, take advantage of the free unlimited eClinicalWorks webinars—interactive seminars conducted online. These courses are presented by product trainers who are experts with eClinicalWorks and all of its capabilities.

To sign up for an eClinicalWorks webinar go to: http://support.eclinicalworks.com/training/index.php
eClinicalWorks Newsletter

To receive important, timely, and informative product notifications, subscribe to the eClinicalWorks Newsletter e-mailing list.
To subscribe to the newsletter, click the link:
- Available on the my.eclinicalworks Customer Portal: [https://my.eclinicalworks.com](https://my.eclinicalworks.com)
- OR
- OR
- eClinicalWorks Newsletter

Getting Support

Send messages directly to eClinicalWorks Support through the eClinicalWorks Customer Portal: [https://my.eclinicalworks.com](https://my.eclinicalworks.com)

You may also call or e-mail eClinicalWorks Support:
- Phone: (508) 475-0450
- E-mail: support@eclinicalworks.com

Conventions

This section lists typographical conventions and describes the icons used to call out additional information and to indicate item keys, new features, and enhancements to the application.

The following typographical conventions are used in this guide:

<table>
<thead>
<tr>
<th><strong>Bold</strong></th>
<th>Identifies options, keywords, and items in a description.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Italic</strong></td>
<td>Indicates variables, new terms and concepts, foreign words, or emphasis.</td>
</tr>
<tr>
<td><strong>Monospace</strong></td>
<td>Identifies examples of specific data values, and messages from the system, or information that you should actually type.</td>
</tr>
</tbody>
</table>

The following icons are used to highlight new features and indicate enhanced features and item keys:

<table>
<thead>
<tr>
<th><strong>Icon</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="pencil.png" alt="Pencil" /></td>
<td>Indicates this is an item key.</td>
</tr>
<tr>
<td><img src="info.png" alt="Information" /></td>
<td>Points out helpful tips or additional information.</td>
</tr>
</tbody>
</table>
ABOUT eCLINICALWORKS P2P

**eClinicalWorks® P2P** is a secure Provider-to-Provider communication network.

* eClinicalWorks P2P facilitates improved quality, safety, and efficiency of care.
* By joining the network, you can further patient engagement, coordination of care, and population health using an intra-practice-to-inter-practice infrastructure.

Setting up eClinicalWorks P2P in your practice is a simple three-step process:

- Administrator Security
- Activation
- Registration

Once this setup is complete, you can begin collaborating with other eClinicalWorks users and start building your own personal network. You can construct your network by:

- Inviting providers
- Accepting invitations from other providers

As your address book grows, you can interact with other providers via messaging and referrals, all on a secure network.

**IMPORTANT!** eClinicalWorks requires all P2P users to follow local, state, and federal level privacy and security requirements. Prior to the transmission and exchange of queries and responses through the secure network, providers should discuss patient consent, obtain authorizations, and provide the HIPAA-mandated Notice of Privacy Practices.
**Activating eClinicalWorks P2P**

This section details the activation of eClinicalWorks® P2P at administrator and provider levels. If you do not have admin privileges, contact your practice administrator.

**Administrative Security Settings**

The practice administrator has the authority to enable or disable the security attribute for eClinicalWorks P2P.

**Enabling the P2P Security Attribute**

The practice administrator has the authority to enable or disable the security attribute for eClinicalWorks P2P. This attribute effectively controls P2P access for all users within the practice.

**To enable the eClinicalWorks P2P security attribute:**

1. Log into eClinicalWorks with Administrator privileges.
2. From the File menu, click Security Settings.
   The Security Settings window opens.
3. Click the *By Security Attribute* Tab:

4. From the left pane, click *eCW P2P Registration*.
Activating eClinicalWorks P2P

The right pane refreshes with the list of providers and staff in the practice.

- **To enable a user:** Click the *Permission* check box next to the user's name in the list.

- **To enable all users:** Click the *Permission* check box at the top of the Permission column. Click the check box again to disable permissions:

![Security Settings (eCW P2P Registration)](image)

5. Click Save to save the permission settings.

The user now has access to eClinicalWorks P2P.

**Note:** If a user without security rights attempts to register for eClinicalWorks P2P, a denial notification displays:

![Denial Notification]

*You do not have permission to join the eClinicalWorks P2P network. Please request your administrator to allow you to join the network by enabling the security attribute 'eCW P2P Registration'*. 
Practice Activation

Activation of eClinicalWorks P2P can be performed in two ways, depending upon the user's privilege level - administrator or provider.

Administrator Level

Practice administrators can activate eClinicalWorks P2P for their practices using the On-Demand Product Activation module, which can be accessed from the left navigation pane:

This icon launches the On-Demand Product Activation window, which includes activation tools for all eClinicalWorks modules, including eClinicalWorks P2P:

The activation wizard provides easy, step-by-step instructions for self-activation of eClinicalWorks P2P.
Activation is a *one-time process per practice*. For example, if one provider in a multi-provider practice activates eClinicalWorks P2P, then eClinicalWorks P2P is activated for the *entire* practice.

Any subsequent providers that access eClinicalWorks P2P will bypass the activation page and be routed directly to registration page.

**Provider Level**

Providers that do not have access to the Admin band can navigate to the My Settings area of eClinicalWorks to activate P2P. Again, activation for a practice is a one-time procedure; only one provider or administrator is required to run the activation.

The provider-level activation is also integrated with the registration process, so the provider that activates eClinicalWorks P2P is also registered for use during the activation.

**To access eClinicalWorks P2P as a provider:**

1. From the File menu, hover over the Settings option to display a second drop-down list.
2. From this list, click My Settings.
   
   The My Settings window opens.
3. Click the eClinicalWorks P2P tab.
   
   The eClinicalWorks P2P tab displays.

   If you are not yet a member, the *Join eClinicalWorks P2P* button displays:

   ![Join eClinicalWorks P2P Button](image)

   4. Click the *Join eClinicalWorks P2P* button to activate the feature.
      
      The Environment page displays:
5. Use the radio buttons to select one of the P2P environments:
   - Choose **Test/Beta** to connect to a beta environment to experiment with P2P risk-free and become familiar with the navigation.
   - Choose **Production** to immediately connect to the network and begin collaborating with live P2P users.

6. Once the environment has been determined, click Activate Now to activate eClinicalWorks P2P for your practice.
   Once you click this button, it prepares the network:
   - Validation of User License
   - Sets up Network Connection Configuration
   - Tests Connectivity - Ping Test
   - Enables Scheduled Tasks
Once activated, the Registration window displays:

The registration page is divided into two halves; the top half is for self-registration, and the bottom half is used for accepting an invitation from another provider in the P2P network.

For this procedure, only the top half of window needs to be completed. Procedures for the bottom half of this window are covered in the section Accepting Invitations on page 25.

7. Complete the required information at the top of the window.
   - First Name
   - Last Name
   - E-mail
   - Password
   - Confirm Password
   - ZIP Code
   - NPI Number - this field contains a NPI Number lookup tool, which can be launched from the Magnifying Glass icon. This NPI list comes from eCW's master list, and it checks and validates all NPI numbers during registration. The NPI field is also enabled for free-text entry of known NPI Numbers.

   **Note:** Be sure to include your NPI number, as this is one of the key pieces of information for finding and identifying providers in the network.

If the registrant is an eCW user, all of this information is pulled from eCW and pre-populates into the Registration window.
8. Click Create Account to register with eClinicalWorks P2P.

After registration, the following window displays on the eClinicalWorks P2P tab for registered users:

No logout/login is necessary - the user is logged in and activated. The eClinicalWorks P2P activation also activates the P2P menu options (green P icons) under the S, T, and M jelly beans:

**S Jelly Bean:**
- eCW P2P Appointments

**M Jelly Bean:**
- Create eCW P2P Message
- Add eCW P2P Providers
**T Jelly Bean:**

- Telephone Enc (0)
- Web Enc (0)

**Actions (0):**

- **eCW P2P Patient Records (5)**

**New Telephone Encounter**

**New Action**

- Create eCW P2P Appointment
- Send eCW P2P Patient Record
- Send eCW P2P Referral/Consult

For information on settings, refer to [Settings](#) on page 19.
REGISTRATION

If eClinicalWorks® has already been activated within the practice, the one-time registration process for all subsequent users is simple - any provider that registers will bypass the activation steps and proceed directly to the registration.

For information on activating and registering, refer to Practice Activation on page 9.

To register for eClinicalWorks:
1. From the File menu, hover over the Settings option to display a second drop-down list.
2. From this list, click My Settings.
   The My Settings window opens.
3. Click the eClinicalWorks P2P tab.
   The eClinicalWorks P2P tab displays:

4. Click the Join eClinicalWorks P2P button.
Registration

The Registration window displays:

5. Complete the required information at the top of the window.
   - First Name
   - Last Name
   - E-mail
   - Password
   - Confirm Password
   - ZIP Code
   - NPI Number - this field contains a NPI Number lookup tool, which can be launched from the Magnifying Glass icon. This NPI list comes from eCW’s master list, and it checks and validates all NPI numbers during registration. The NPI field is also enabled for free-text entry of known NPI numbers.

   **Note:** Be sure to include your NPI number, as this is one of the key pieces of information for finding and identifying providers in the network.

   If the registrant is an eCW user, all of this information is pulled from eCW and pre-populates into the Registration window.

6. Click Create Account to register with eClinicalWorks P2P.
After registration, the following window displays on the eClinicalWorks P2P tab for registered users:

Information on the schedule access settings found on this Settings window, refer to Schedule Access on page 20.

No logout/login is necessary - the user is logged in and activated. The eClinicalWorks P2P activation also activates the P2P menu options (green P icons) under the S, T, and M jelly beans:

**S Jelly Bean:**
- Review Progress Notes (2)
- Office Notes
- Resource Schedule
- eCW P2P Appointments

**M Jelly Bean:**
- Inbox (4)
- eCW P2P Invitations (0)
- Outbox
- Deleted Messages
  
- Create New Message
- Create eCW P2P Message
- Add eCW P2P Providers
T Jelly Bean:

- Telephone Enc (0)
- Web Enc (0)
- Actions (0)

- p eCW P2P Patient Records (5)

- New Telephone Encounter

- p Create eCW P2P Appointment
- p Send eCW P2P Patient Record
- p Send eCW P2P Referral/Consult
POST-REGISTRATION

This section details the settings to be configured by eClinicalWorks providers after registering for eClinicalWorks® P2P.

Settings

Once your activation is complete, your profile page displays on the eClinicalWorks® P2P tab. Use this page to manage your settings, including your profile picture. The profile options include:

- Profile picture
- Name
- Position
- Location of practice
- Phone number
- Member Since - this is a dynamic running counter that begins after activation.

Your Profile Picture

There is an easy-to-use profile picture tool that allows you to upload a picture from your computer and crop it - all from right within the profile page.
To add or change your profile photo:

1. From the eClinicalWorks P2P tab, click the Change link.

   The picture upload dialog box opens:

<table>
<thead>
<tr>
<th>Upload your picture</th>
<th>Browse</th>
<th>Cancel</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Picture</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2. Click the *Upload your picture* radio button, and then click Browse to locate your photo on your computer.

   **Note:** Photos must be in JPEG (.jpg) format.

3. Once you've located your photo on your computer, highlight it and click Open:

   ![Choose File to Upload]

   Your photo will be loaded into the photo position, and you can use the Crop tool to adjust the size and position of your photo.

4. When the photo is positioned and resized to your liking, click the Apply Changes button to save it.

   Click Cancel if you want to exit without saving a photo.

   You also have the option to leave your photo blank or remove an existing photo at any time. Just click the *No Picture* radio button on the picture upload dialog box.

**Schedule Access**

The Schedule Access tool allows you to manage your schedule availability to other providers in the eClinicalWorks P2P network.

The access settings let you determine:
if you would like other providers to be able to reserve appointments on your calendar
which providers can reserve appointments:

There are two radio button options on the Settings page, and they offer the ability to allow
or disallow any number of network providers to access your schedule to reserve
appointments.

You may choose to allow access to a small group of known providers in your My Favorites
list, or you may open your schedule to any provider in the network; the choice is yours.

Use the Configure User Level Access link on the option to allow or disallow access to specific
providers. Use the radio buttons and filters on the window to find providers and set their
permissions:

The legend at the bottom of the page indicates the row shading associated with each
provider in the list.
BUILDING YOUR eCLINICALWORKS P2P NETWORK

Once eClinicalWorks® P2P has been activated, users can begin building their network and collaborating with other providers. A successful network is comprised of trusted or referred providers that exchanges mutually beneficial information, but it can used for less formal messaging and social networking as well.

Building your network begins with sending invitations to providers.

To send an invitation, use the various invitation methods located on the Invitations page. The options are:

- Find a provider and send an e-mail
- Send an e-mail
- Send a fax

The e-mail message sent to providers will be tailored for each situation; if the user is not on P2P, the message invites them to join. If the user is currently on the P2P network, the e-mail message invites the provider to connect with the inviter.

Sending Invitations

One way to build your network is to directly invite colleagues using the invitation tools within eClinicalWorks P2P. eClinicalWorks uses the national provider database, which is based on NPI identification numbers, so finding providers is a simple one-click process, regardless of their geographical location.

To send an invitation:

1. Click the M (Messages) jelly bean in the toolbar to display the P2P options. P2P messaging options are indicated by green P icons.
2. Click the Add eCW P2P Providers option:

   Inbox (4)
   ☐ eCW P2P Invitations (0)
   Outbox
   Deleted Messages
   -----------------------------
   Create New Message
   ☐ Create eCW P2P Message
   ☐ Add eCW P2P Providers

The P2P window opens, which is divided into three accordion-style panels:

- My Favorites (open by default)
- My Address Book
- Invite Providers to join you on eClinicalWorks P2P
3. Click the Invite Providers... heading to open the Invitation window:
4. To locate and contact a provider, there are three options:

- **Find Provider and Send an E-mail:** Use the Provider or Specialty filters to locate the provider, and then click the Invite button adjacent to the provider's name. This action opens an invitation window, which includes an area for a short message. Click Send Invitation to contact the provider.

- **Send an E-mail:** Enter a known e-mail address, name, and an optional note, and then click E-mail Invitation.

- **Fax an Invitation:** Enter a known fax number, name, and an optional note, and then click Fax Invitation.

**Note:** Providers that are currently connected to you will NOT appear in your Master search list. Once they accept an invitation to connect, they are immediately removed from this list. If they are de-activated, they will reappear in the list.

The invitation is sent to the provider as an e-mail or fax message. The e-mail message includes instructions for accepting the invitation and joining the network:

![Image of e-mail invitation]

The invitation includes a registration key for existing eClinicalWorks users, or a link for non-eClinicalWorks users.

Once the user accepts your invitation with one of these methods, they are automatically added to your contacts under My Address Book:
Once a provider is saved in your Address Book, you have the option to add them to your My Favorites list.

For information about creating and using your My Favorites list, refer to My Favorites on page 28.

For information on receiving and accepting invitations, refer to the section Accepting Invitations.

**Accepting Invitations**

Like most steps in the eClinicalWorks P2P network-building process, accepting invitations is simple and intuitive. Invitations fall into two general categories - fellow eClinicalWorks users or non-eClinicalWorks users.

There are two distinct methods for accepting invitations depending upon these two scenarios.
eClinicalWorks Users

To connect to eClinicalWorks P2P:

1. When an eClinicalWorks P2P invitation is sent to a fellow eCW user, the invitation method includes a unique alphanumeric invitation key:

   **Registration**

   Follow the instructions below to register an account:

   **Existing eClinicalWorks Users**

   Paste the following invitation key into the eClinicalWorks P2P registration (File > Settings > My Settings > eClinicalWorks P2P tab):

   **Invitation Key:** a3249b9b6340809bf10823577fb6e7e2

   **Note:** This key is for one-time use only by the intended recipient.

2. Highlight and copy the entire invitation key characters (Ctrl+C).
3. From the File menu, hover over the Settings option to display a second drop-down list.
4. From this list, click My Settings.
   The My Settings window opens.
5. Click the eClinicalWorks P2P tab.
   The eClinicalWorks P2P tab displays:

   ![](image)

6. Click the Join eClinicalWorks P2P button.
Building Your eClinicalWorks P2P Network

Accepting Invitations

The Registration window displays:

**Invitations**

If you received an email invitation to join eCW P2P, use it below or create an account.

If you use an invitation key, the user who invited you will receive a notification when you register. We will also add the contact to your favorites so you can start collaborating right away.

Enter invitation key here: 

Create Account

7. Paste the invitation key into the Invitation key field (Ctrl+V), and click Create Account. The provider is now connected to eClinicalWorks P2P network and all related information is displayed in the address books of both the sender and the recipient.

For information on sending invitations, refer to Sending Invitations on page 22.

Non-eClinicalWorks Users

Invitations sent to non-eClinicalWorks users include a URL hyperlink to the eCW P2P Portal, which was created specifically for non-eClinicalWorks users. This portal is structured like a traditional e-mail application, with Inbox, Sent Mail, and Archived folders.

Registration

Follow the instructions below to register an account:

Existing eClinicalWorks Users

Paste the following invitation key into the eClinicalWorks P2P registration (File>Settings>My Settings>eClinicalWorks P2P tab):

Invitation Key: a3249b96340809bf1082357fb6e7e2

Non-eClinicalWorks Users

Please follow the link to join:
http://srvdevsingh:9090/mispisدور/jsp/referral/accounts/newAccount.jsp?IE=a3249b96340809bf1082357fb6e7e2

Thank You,
eClinicalWorks eClinicalConnect P2P Team
When the invitee clicks on the web portal URL, the registration window displays and carries the provider through the registration process.

For more information on the using the web portal, refer to eCW P2P Portal on page 40.

Managing Invitations

For eClinicalWorks EHR users, invitation can be managed from the eCW P2P Invitations window. This window can be accessed from the M jelly bean:

This option launches the eCW P2P Invitations window, which contains two tabs: Unread eCW P2P Invitations and All eCW P2P Invitations:

My Favorites

Once providers are connected to you on the eClinicalWorks P2P network, you can mark your favorites or frequently contacted providers in the My Favorites tab of the P2P module for quick access.

This feature becomes more useful as your list of connected providers expands and your network grows.

To mark a provider as a favorite, locate the provider in the My Address Book tab, and click the yellow star next to their name:
This provider is now marked as a favorite, and their profile and contact information displays on the My Favorites tab:
Referrals can be sent or received through eClinicalWorks® P2P, to and from eCW and non-eCW providers alike.

**Sending Referrals**

Referrals can be sent from the Referrals window in the patient workflow, or directly from the P2P referral option under the T jelly bean. The instructions that follow begin from the T jelly bean; the workflow from the Outgoing Referral window within a patient’s Progress Note is similar.

**To send a referral using eClinicalWorks P2P:**

1. From eClinicalWorks, click the T jelly bean to display a drop-down list.
2. From this list, click Send eCW Referral/Consult, which is indicated by a green P2P icon:

   - Telephone Enc (0)
   - Web Enc (0)
   - Actions (0)
   - eCW P2P Patient Records (5)
   - ------------------------------
   - New Telephone Encounter
   - New Action
   - Create eCW P2P Appointment
   - Send eCW P2P Patient Record
   - Send eCW P2P Referral/Consult

   The Referral (Outgoing) window opens, and the logged-in user's name displays in the Ref From field.

3. In the Refer To section, click the More (...) button to open the Referring Physician Lookup page:

   ![Referral (Outgoing) window](image)

   You may also filter the results list by specialty by using the Specialty drop-down list prior to searching by provider name.

   The Referring Physician Lookup window opens, with two tabs displayed: Referring Providers and eCW P2P Providers. The eCW P2P Providers tab includes a search window
that queries all providers who are currently on the eCW P2P network. This tab opens to
the logged-in user’s My Favorites list by default:

The "people" icons indicate that the providers have the ability to exchange data via
eClinicalWorks P2P:

All eCW P2P providers are listed on the eCW P2P Providers tab.

4. Use the search tool on either tab to locate the provider who will receive the referral:

5. Use the radio button to select the provider and then click OK.
The selected provider is added to the Refer To field.

6. Complete the referral details as usual, and includes any attachments if needed.
For more information on attachments, refer to [Attachments](#) on page 42.
7. When the referral details are complete, click the Send Referral button to choose a delivery option:

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print</td>
<td>Prepares the referral for printing and displays the Print dialog box.</td>
</tr>
<tr>
<td>Print with Attachments</td>
<td>Prepares and previews the referral and attachments for printing and displays the Print dialog box.</td>
</tr>
<tr>
<td>Fax</td>
<td>Prepares and previews the referral for faxing and displays the Fax Preview window.</td>
</tr>
<tr>
<td>Fax with Attachments</td>
<td>Prepares and previews the referral and attachments for faxing and displays the Fax Preview window.</td>
</tr>
<tr>
<td>Send Instantly via eCW P2P</td>
<td>Gives the option to send the referral via the eCW P2P network, and also gives the option to reserve an appointment on the referred provider’s schedule (if available).</td>
</tr>
</tbody>
</table>

Note: This option is available only when both sending and receiving provider in the referral are registered on the eCW P2P network.

a. If you choose to send the referral instantly through the eCW P2P network, click the Schedule & Send Referral button:
b. Enter the preferred date and times and click Search.

**Note:** The Date, Start Time, and End Time fields have easy-to-use pop-up scheduling tools such as calendars and preset time slots to speed the entry process. Click in the field to open the respective tool.

The window will refresh with the available time slots for the referred provider.

c. Click the Book button for the best available time slot.

A confirmation window displays when the appointment is successfully reserved:

If necessary, click Print to print the confirmation for the patient.
SCHEDULING

eClinicalWorks® P2P streamlines the referral process dramatically by allowing access to the schedules of collaborating providers.

Appointments can be scheduled on another provider’s schedule from two locations: the Referral window and the T jelly bean:

Creating eCW P2P Appointments

The instructions that follow begin from the T jelly bean; the workflow from the Outgoing Referral window within a patient’s Progress Note can be found in the section Referrals on page 30.

To create an eCW P2P appointment:

1. From eClinicalWorks, click the T jelly bean to display a drop-down list.
2. From this list, click Create eCW P2P Appointment.

The Create New eCW Appointment window displays:

3. In the Patient row, click the More (...) button to open the Patient Lookup window to select the patient for the appointment.
4. In the Send To row, click the More (...) button to open My Address book to locate the provider on the P2P network.
5. Click Book Appointment to reserve an appointment on the provider’s schedule.

The Schedule Appointment window opens for the referred provider:
6. Enter the preferred date and times.

**Note:** The Date, Start Time, and End Time fields have easy-to-use pop-up scheduling tools such as calendars and preset time slots to speed the entry process.

Click in the field to open the respective tool:

**Date Calendar:**

**Time Slots:**

7. Click Search.

The window will refresh with the available time slots for the referred provider.
8. Click the Book button for the best available time slot. A confirmation window displays when the appointment is successfully reserved:

If necessary, click Print to print the confirmation for the patient.

Managing eCW P2P Appointments

eCW P2P Appointments can be managed from the eCW P2P Appointments window, which can be accessed from the S jelly bean:

The eCW P2P Appointments window contains two tabs - Received and Sent. The Received tab displays the high-level details appointments scheduled on the logged-in provider's schedule, such as Patient Name, Appointment Date/Time, Appointment Provider, and Appointment Location:
Received Tab:

The Sent tab displays similar high-level details of all P2P appointments scheduled by the logged-in provider. The information includes Patient Name, Appointment Date/Time, Appointment Provider, and Appointment Location, as well as the real-time status of the booked appointment.

Sent Tab:
MESSAGING

Messages can be sent between providers quickly and easily using the secure eClinicalWorks® P2P network, and both eClinicalWorks and non-eClinicalWorks providers can use this feature.

To send a message to another provider within the network:

1. From the Menu bean, click Create eCW P2P Message:

The Send eCW P2P Message window opens, with the name of the logged-in provider in the From box. This field is not editable.

2. Click the More (…) button to open My Address book, and select recipients for the message.

3. Enter a Subject for the message.

4. Enter the message body.

   Use the More (…) button next to the Message field to insert saved keywords or commonly used text and phrases.
5. Click Send to send the message.

The message is sent to the recipients. eClinicalWorks users will receive this message in their Messages Inbox under the M jelly bean, as well as in their eClinicalWorks P2P Portal inbox.

Non-eClinicalWorks users will receive the message in their eClinicalWorks P2P Portal inbox only.

**Note:** Attachments cannot be appended to basic messages; use the Send eCW P2P Patient Record option under the T jelly bean for sending records/attachments via the network.
The secure eClinicalWorks® P2P Portal is available for both eCW users and non-eCW, from any location or device with an Internet connection.

The P2P Portal is the one place where all non-eClinicalWorks users can interact with the P2P network, and eCW users can utilize the portal for exchanging basic information when they are away from the office.

The eCW P2P Portal functions like a traditional e-mail application, with an Inbox, Outbox/Sent Mail, and Archived folders for messages. All of these areas have a similar structure and workflow:

The portal also contains a Contacts list for contacts within the P2P network, and an Invitations tab to help the user manage invitations and check their statuses:

### eCW P2P Messages

Sending and receiving messages through eCW P2P is no different than most traditional e-mail applications.

The Inbox includes lists all incoming messages and their associated information such as sender name, subject, date created, and any attachments.
Sending Messages

Messages can be sent from the eCW P2P Portal with attachments, if necessary. The **To** field includes a real-time search of your P2P contacts, which allows for fast and error-free entry. Click **Attach Patient Record** to upload file, and then enter the first and last name of the associated patient.

The message body field contains the standard font tools found in most e-mail applications to help customize the look and feel of your messages:

Messages sent to eClinicalWorks providers will display in the provider's Messages Inbox under the M jelly bean, and in their portal Inbox.

Messages sent to non-eClinicalWorks users will display in their portal Inbox.

Sent messages can be managed from the Sent Messages tab.

Receiving Messages

Incoming messages are routed into the Inbox, and the provider can read, reply, forward, or delete messages. Simply click the e-mail row to open it. If the message includes an attachment, icons for these attachments will display within the row:
Attachments

For messages between two eClinicalWorks EHR users, attachments can include Progress Notes, Medical Summaries, Lab Reports, X-Rays and Imaging, and Documents, in addition to the following supported file types:

- .bmp
- .gif
- .jpeg, .jpg
- .pdf
- .png
- .tif, .tiff

Non-eClinicalWorks users can attach only:

- .bmp
- .gif
- .jpeg, .jpg
- .pdf
- .png
- .tif, .tiff

Note: Microsoft-based products (e.g., Word®, Excel®, etc) are not supported at this time.

Contacts

The Contacts tab in the eCW P2P Portal contains a list of all P2P network contacts for the provider:

The Contacts window displays the provider's picture (if available) name, address, fax number, specialty, and My Favorites status.
Invitations

Invitations to join the eCW P2P network can be managed from the Invitations section of the portal:

The Search tool at the top lets you find providers easily, and then invite them to your network with one click. If you are unable to locate a provider using the Search tool, use the *Invite by Sending an Email* button at the bottom of the window. Just enter a known e-mail address for the provider to send the invitation directly.

The Invitations section has straightforward Received and Sent panels that help you keep track of sent, received, and pending invitations.
**My Profile**

eCW P2P Portal contains a user profile section called My Profile. The profile information gives other network users your demographics and contact information, as well as an optional personal picture:

```
<table>
<thead>
<tr>
<th>Picture:</th>
<th><img src="image" alt="Profile Picture" /></th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name:</td>
<td>Kavita</td>
</tr>
<tr>
<td>Last Name:</td>
<td>N</td>
</tr>
<tr>
<td>Middle Name:</td>
<td></td>
</tr>
<tr>
<td>Speciality:</td>
<td>Internal Medicine</td>
</tr>
<tr>
<td>Mail Address:</td>
<td>201 High St</td>
</tr>
<tr>
<td>City:</td>
<td>Clinton</td>
</tr>
<tr>
<td>State:</td>
<td>CA</td>
</tr>
<tr>
<td>Zip:</td>
<td>01037</td>
</tr>
<tr>
<td>Practice Phone:</td>
<td>9773608237</td>
</tr>
<tr>
<td>Preferred Contact Number:</td>
<td></td>
</tr>
<tr>
<td>Fax:</td>
<td>977361214</td>
</tr>
</tbody>
</table>
```

For information on how to upload and crop your personal picture, refer to *Your Profile Picture* on page 19.

**Settings**

The eCW P2P Portal Settings window allows the provider to determine which message options should trigger a notification, and to which e-mail account the notification should be sent:

```
<table>
<thead>
<tr>
<th>Notifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Referral</td>
</tr>
<tr>
<td><a href="mailto:kavilani@mail.com">kavilani@mail.com</a></td>
</tr>
</tbody>
</table>
```

- A notification for any new messages received will be sent to the specified email address.
COMMUNITY

The eClinicalWorks® P2P Community feature was created to allow community hierarchy within the P2P network. It gives administrators the ability to structure their own communities, and lets them manage the levels of their community effectively.

eClinicalWorks P2P communities are managed through a web portal that was designed specifically for building and maintaining P2P community relations.

Access

Access to the P2P Community web portal is restricted to Community administrators. The web portal allows these administrators to add both eCW and non-eCW users to the community network, and keep track of pending invitations.

Community administrators can receive their Community portal login credentials from their eClinicalWorks Project Manager.

Building Communities

Communities can be formed with members of eCW and non-eCW providers alike. The invitation process varies slightly depending upon the provider's scenario.

There are four basic scenarios for community invitees:

- eClinicalWorks users registered on the eCW P2P network
- eClinicalWorks users not registered on the eCW P2P network
- Non-eClinicalWorks users registered on the eCW P2P network
- Non-eClinicalWorks users not registered on the eCW P2P network
To add eClinicalWorks practices to the community:

1. To add eClinicalWorks EHR users, click the Add Practice button:

   - The Subscription dialog box opens:

   - Enter the APU ID number of the practice.
     - Your practice APU ID number can be found within the eClinicalWorks application. From the Help menu, click About eClinicalWorks, and then click the APU Info button:

2. Enter the APU ID number of the practice.

   - Your practice APU ID number can be found within the eClinicalWorks application. From the Help menu, click About eClinicalWorks, and then click the APU Info button:

   An electronic notification will be sent to the practice with the activation instructions.
3. Click the Subscribe button.

Invitations are sent to the selected providers, and their status displays as Pending in the Pending eCW P2P Network Invites section:

At this point, the invite notification workflow is dependent upon the invitee's role:

- **Practice Administrators** are notified via a message on the Community panel under the eClinicalWorks P2P Administration icon on the Admin Band:

- **Existing P2P Network Providers** are notified in their P2P inbox within the eClinicalWorks application, and also via a message at the bottom of their My Address Book window:
4. For each scenario, click the Accept button to join the community.

When the invitees accept the invitation to join the community:

- **Community Administrators** will receive confirmation and activated community providers will display in their community panel, and their My Address Book will be populated with all users in the community.
- **Existing P2P Network Providers** will be connected to the community and their My Address Book will be populated with all users in the community.
- **New eClinicalWorks P2P Providers** will be directed to the registration page. Once registered, they will be connected to the community and their My Address Book will be populated with all users in the community.

**To add non-EHR users practices to the community:**

1. In the Community Users section, enter the user’s name into the Search Providers field.

This is a real-time search that scans the master list of providers and provides search matches as you type:

Providers who have already joined this community are distinguished in the list by green font and cannot be selected.
2. Click the provider name to select, and the related information is populated into the required fields.

3. Enter the selected provider's e-mail address into the E-mail Address field. This is a required field.

4. Continue searching for and adding providers as needed.

   To remove a selected provider before activating, click the red minus sign icon:

5. When all invitees have been selected, click the Activate button.

6. The invitation is sent to one of two locations, depending upon the provider's P2P network status:

   - If the provider is currently part of the P2P network, the community invitation displays in the Pending Invitation section of the provider's eCW P2P Portal.

   - If the provider is not currently part of the P2P network, the provider is notified via e-mail, and is instructed to register for P2P on the portal. Once the provider has been registered and activated on the P2P network, they will also be added to the community that sent the invitation, and their Address Book will be populated with all members of that community.
APPENDIX A: NOTICES

Trademarks

eClinicalWorks®

eClinicalWorks is a registered trademark of eClinicalWorks, LLC. All other trademarks or service marks contained herein are the property of their respective owners.